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Logistics

¢ Online and will be recorded

* Today's presentation & recording will ‘l

be uploaded onto RA history website
*https://www.cpuc.ca.gov/General
.aspxeid=6316

« Safety
« Note surroundings
and emergency exits
« Ergonomic check
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Logistics
« All attendees have been muted
« To ask questions, please use the "Q&A" function (send "To All
Panelists") or raise your hand

« Questions will be read aloud by staff; attendees may be unmuted to
respond to the answer. (Reminder: Mute backl)

Mute/ Unmute Participant List Chat Audio Options "Q&A": on the bottom right of

\ l j / screen, click "3 dofts"
e @ e @ . o - \

>4

L. Participants (1) Chat
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RA Reform Background

« D.21-07-014: Adopted “slice-of-day” (SOD) concept and six principles.
Established a process and timeline for developing a final restructuring
proposal based on PG&E's “slice-of-day” proposal.

« D.22-06-050: Adopted SCE’s 24-hour approach to the “slice of day”
framework. Directed additional working groups and submittal of a
working group report to address remaining implementation details.

« D.23-04-010: Adopted implementation details including compliance
tools, resource counting rules, test year details and coordination with

CAISO processes.
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Next Steps — Test Year Implementation

* LSE Compliance Templates — Used for SOD RA showings.

» Master Resource Database (MRD) — CPUC will maintain an official database of resources eligible
to sell RA that includes their key attributes, as listed below. Resources must be fully represented in
the MRD to be eligible for use in the 24-hour slice RA showing.

« Planning Reserve Margin (PRM) Calibration — A SOD calibration tool is adopted that will convert
the results of a LOLE study to the SOD framework.

 LSE Filings for 2024 Test Year — LSEs are required to make year-ahead SOD filing by November 30,
2023, and month-ahead compliance showings for March, June and September by the first day
of the showing month.

+ SOD showings also used if LSE showing storage in MCC bucket 4.

« Assessment Report - CPUC staff to solicit public feedback after key milestones during the 2024
test year, and to prepare a report summarizing the feedback after the year-ahead test showings
(due by February 1, 2024). Stakeholders will have an opportunity to provide formal comment on
the staff report.
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Agenda

« Update on Hourly Load Forecast — Lynn Marshall, CEC
» Slice of Day Showing Tool — Robert Hansen, Energy Division
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Resource Adequacy
Monthly Slice-of-Day Showing

Proposed Template

Design and Usage

September 7, 2023
Presented by Robert Hansen
Senior Utilities Engineer

Resource Modeling Team




Ovutline

» Presentation Objectives
» Template Design

» Preparing a Showing

» Reviewing a Showing

« Demonstration

* Project Timeline

« Questions
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Introducing the Resource Adequacy Slice-of-Day Showing Template
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Presentation Objectives

« Familiarize users with the template design

« Demonstrate how to input a slice-of-day showing
« Review validation tests

« Address user guestions
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Overview of the Slice-of-Day Resource Adequacy Showing Template
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Template Design - Primary Considerations

The Slice-of-Day RA Template should:

« Clearly communicate capacity obligations and allocations to Load-
Serving Entities

 Integrate with the new Slice-of-Day framework for system requirements
 Provide built-in validation checks to test showings prior to submittal
« Offer useful charts to visually compare showing against requirements

« Help users show single- and multi-cycle storage resources based on
need
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Tables and Queries

Higher-order data structures for improved stability
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Template Design

Tables and Queries

More structured than Cells and Ranges
Manageable naming for tables and columns
Automatically resizes range for, e.g., aggregation calculations

Data Connections load Tables defined in Worksheets into Power Query,
effectively building a relational database inside a single Excel file

Query calculations tend to be easier to read and follow across multiple
steps than equivalent cell formulas

The M language used in Power Query differs from Excel formulas, but should
be comprehensible to many users familiar with Excel
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Template Design - Tables vs. Ranges

Range of Cells Table
A | | C
2 Row 1 417 120 22 Row 1 417 120
3_ Row 2 433 872 3_ Row 2 433 872
4_ Row 3 380 313 4_ Row 3 380 313
Excel Formula: Excel Formula:
=SUM(B2:B4) =SUM(Table1[Column 2])
Result: Result:
1,230 1,230
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Template Design — Queries

Power Query Editor
il -

Home Transform Add Column

Murmber Tools ~ DataTable - Power Query Editor O *

Wiew Transform | 0

[_j 10? /A Trigonemetry =
: 00 ;
5 Rounding =

To Standard Sdentific

Table = - - Information ~
Conwvert Transform

J
123 DataTable1
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PROPERTIES

Name

All Properties

APPLIED STEPS

Source
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Template Design — Queries vs. Cell Formulas

Example Comparison: Checking Number of Hours Shown

« Power Query:

#"Added Valid Hours" = Table.AddColumn (
#"Expanded ResourceMasterDatabase",
"Valid Hours",

each [Hours Shown] <= [[RESOUECEDAEabaSE Maximum DLy RUAHOUES] .

type logical
)

e Cell Formula:

=IF(
COUNTIF ($013:$AL13,">0") <=

) , "Pass", "Fail")
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Workbook Organization

Distinguish data sets based on their source



Workbook Organization

Three types of data built into the template file in color-coded groups of
sheets:

 LSE Showmg (Inpu’rs)

Resource Custom Profiles Profile Optimization

» LSE Requirements and Allocations (Included and unique to each LSE)

Requirements and Allocations

« Resource Descriptions (Included and common across LSEs)

Resource Database Resource NQC Resource Default Profiles
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Workbook Organization

Two groups of sheets used for reviewing a showing:

 Tabulated Results

« Showing Charts

Hourly Availability Chart Local Availability Chart Flex Availability Chart
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Workbook Organization

* Most worksheets contains a single table
 This should make it easier to find and input required information

« “Certification” contains no table, instead maintaining a format similar to the

LSE Filing template, but its data is loaded into a table in the hidden
“Certification Table” sheet

» “Profile Optimization” contains multiple tables to setup an optimization
problem for Solver
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Workbook Organization

« Only the LSE Showing worksheets (blue tabs) should be edited by LSEs

» LSE Requirements worksheets (orange tabs) and Resource description
worksheets (green tabs) will be updated by CPUC and included in
blank templates sent to each LSE

» The Showing Results and Information worksheets (gold and grey tabs)
update automatically and can help determine whether a showing is
compliant
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Workbook Organization

 Input tables are loaded into Power Query for most calculations

 See Data=>Queries & Connections in the riblbon menu for the list of
queries

« Double-click on any listed query to open the Power Query Editor and
inspect the calculations
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Workbook Organization - Power Query

Interconnected Queries handle most calculations and load results to
worksheets
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Workbook Organization - Power Query

* Queries must be refreshed after changes to input data
« VBA scripts trigger refreshes when opening certain sheets to refresh relevant queries only when
necessary (see “ThisWorkbook™ in the VBA editor):
» LSE Showing Complete
« System Availability Chart
« Local Availability Chart
« Flex Availability Chart

« Buttons on two sheets allow users to manually frigger refreshes as needed
 Profile Optimization
« Validation Overview

» Refresh status appears at the bottom of the window

|| Resource Custom Profils
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Specifying Resources and Slice-of-Day Profiles
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| B

Mon’rhly Showing Certification Form

Preparing a Showing ] e

4 | Date of Fling: 6/14/2024
5 | Load Basis:
6 Fex Category:

Certification Form

Corglstent with Rules 1 and 2.4 of the CPUC's Rules of Practice and Procedure, this

® S h O U | d b e p O rTi O | |y C O m p | e -I- e d resource adequacy showing has been wverified by an officer of the corporation, who

shall expressly certify, under penalty of perjury, the folowing:
1. I'have responsiility for the activities reflected in this showing:

upon receipt with at minimum

3. Based on my knowledge, information, or belief, this fling does not contain any untrue

'I- h e LS E n G m e O n d S h OWi n g statement of a material fact or omit to state a material fact necessary to make the
statements made;

4. Based on my knowledge, information, or belief, this fling contains all of the information

m O n 'I'h required o be provided by CPUC orders, rules, and regulations.
o . o o
o Fl” |n WI-I-h O” GppllCO ble 1:\ LSE Officer Information

. . il Title: Manager

2 N i 1 D
information -
14 | Phone: 123-555-0000

» The form constitutes attestation

Backup Ceontact Information

. . , 17 | Title: ASS\STON to the Manager
of a submitted showing’s o e
20 Phone: 123-555-0001

O C C U TCI Cy T Load Serving Entity Information

L3E Address Line 1: 123 Fake Street

24 | L3E Adldress Line Z2:

25 | LSE City: Rancho Irreci
26 | LSE State: CA

27 LSE 7ip:97531

California Public Utilities Commission

27




Preparing a Showing - LSE Showing Worksheet

LSE Showing

 Pre-filled with any CAM Storage allocation

 Input additional resources as new rows in the table

« Resource IDs and SublDs generally must match Resource Database

« “Use Default Profile” for most resources, unless specifying a custom
profile or requiring automated optimization

[ ‘ J | K ‘ L

NQC or VER Committed

Under Contract Flexible RA Capacity Effective apacit ective  Counterparty if

Unspecified Use Default
aaaaaaaaaaaaaa H (mw) B Local RA (MVE (MW)
2 Storage v 20 0

not available [l McC Bucket 4 Bl Import B rrofile [ - |
TEST FALSE FALSE

aaaaaaaaaaaaaaaaaa
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Preparing a Showing - LSE Showing Worksheet

LSE Showing

« The showing month indicated on the Certification worksheet must be
fully contained by the Capacity Effective Start and End Dates

« Unspecified Import resources need not match Resource Database but
need to be flagged as such

« Storage resources indicated as MCC Bucket 4 are subject to the both

the regular Storage Excess Capacity Test and a second, similar test for
MCC Bucket 4.

| | = H | ! | J | K
NQC or VER ommitte: SCID or
Under Contract Flexible RA Capacity Effective  Capacity Effective  Counterparty if Unspecified Use Default
eeeeeee B (Mw) B Local RA (MVE (MW) B start Date B End Date B2 not available B McC Bucket 4 B import B profile
20 0 8] 2024-09-01 2024-08-30 TEST FALSE FALSE %
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Preparing a Showing - Resource Custom Profiles

When default slice-of-day profiles are not applicable for resources,
custom profiles may be entered manually

« Set "Default Profile” to false on the LSE Showing worksheet

« Copy Resource ID and SublD from LSE Showing worksheet into a new
Resource Custom Profiles worksheet

* Fill in custom MW capacities for each slice-of-day hour
« Custom profiles must not exceed NQC or VER MW Under Contract

30
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Preparing a Showing - Resource Custom Profiles

| ContractID Bl Resource SublD
Bl <o storoge
Contract 1 LNCSTR_6_SOLAR2 SN

LNCSTR_6_SOLARD_LESR

ALTWD_2 COAWDY
ALAMT 7 ESL

NaCor VER
Under Contrack

' (esource SublD

Committed
FlexibloRA  Capacity Effective
B Local RA (MVER (MW] Bl start Date
0 ] [} 20240301
3 o 3 2024-09.01
525 o 52¢ 20260801
21 ) . 28
10 o L]
B a B
o o
o o
0 (] 10
@ o [ o
10 0 L} 20240901
557 567 o 20240901
100 o [y 20260901
15 a0 2004-03.01

20240501

c I} % L £ Il

MW HE MW HE MW HE MW HE MW HE MW HE MW HE MW HE MW HE MW HE MW HE MW HE MW HE M

B1 H> HB: H:
(al

{Capacity Effective

2024.09-30 TEST
202409.30 TEST
2024-09-30 TEST
20240930 TEST
202403-30 TEST
20240930 TEST
20240930 TEST
2024-09-30 TEST
20240930 TEST
2024.09-30 TEST
40930 TEST
0930 TEST
202403-30 TEST
20240930 TEST
2026.09-30 TEST

B

Hs
=

IF G H

scibor
Counterparty Il
B not svallable Bl MCC Bucket 4 Bl import

[ -

[ - E

Unspecified

[ - E]
7

Use Default
B rrofile

FALSE FALSE
FALSE TRUE
FALSE FALSE
FALSE TRUE
FALSE TRUE
FALSE FALSE
FALSE TRUE
FALSE FALSE
FALSE FALSE
FALSE FALSE
FALSE FALSE
FALSE TRUE
FALSE FALSE
FALSE TRUE

K

| - ]

L

- B3

M

N

s LT u Vv W X Y z

MW HE MW HE MW HE MW HE MW HE MW HE MW HE MW HE

His H1o H2o H2 H2»2 H22 H2 H
1

Showing
worksheet.

0 0 fl fl hl B 0 0 0 0 0 0
1-] Il o 0 0 0 0 e 10 "~ P 0 10 0 0 0 0 0 0 0 0 0
1 o 25 O =
Resource ID
Enter a Resource F'” |n
1D from the LSE
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Preparing a Showing - Optimize Storage Profiles

Storage resources may be shown with default, custom, or optimized
profiles

To automatically optimize storage resources according to their physical
capabilities:

« Set "Default Profile” to false on the LSE Showing worksheet

« Do not list the resources in Resource Custom Profiles worksheet

« On the Optimize Profiles worksheet, click the three buttons in the
following sequence:
1. Refresh Tables
2. Reset Shown Hours
3. Optimize Shown Hours
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6 Howdo Ontimize [ rnna Racanreac:

4015 of the squared differenc
a1 n R Required M

1wl
52| capacity with a falloff based on
d capacity and storage

Optimization Group ID

Multh-Cycle torage: 2,86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multh-Cycle Storage: 2,86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cydlestorage: 2.86 Cycles
Mult-Cyclestorage: 2,86 Cycles
Multi-Cydlestorage: 2.86 Cycles
Mult-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Mult-Cyclestorage: 2.86 Cycles
Multi-Cydlestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2,86 Cycles
Multi-Cydlestorage: 2.86 Cycles
Mult-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Mult-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.86 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multh-Cyclestorage: 2,79 Cycles
Multi-Cydlestorage: 2.79 Cycles
Multi-Cycle torage: 2,79 Cycles
Multi-Cydlestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cydlestorage: 2.79 Cycles
Multi-Cyclestorage: 2.73 Cycles
Multi-Cyclestorage: 2,79 Cycles
Multi-Cyclestorage: 2.79 Cycles
MulthCycle torage: 2,79 Cycles
Multi-Cydlestorage: 2.79 Cycles
Mult-Cyclestorage: 2,79 Cycles
Multi-Cydlestorage: 2.79 Cycles
Multi-Cyclestorage: 2,79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles
Multi-Cyclestorage: 2.79 Cycles

single-Cyclestorage

Hour

Ending _Show Hour

onswn e R BRREEESEGEEEES e~ 0w o R BN REEESEGEEREE D oS00 -

0.00%
067%
1736
2.80%

0.00%
0.00%
0.00%
0.00%
0.00%

14,21%
18.26%
23.%%
25.99%

19.50%
14.87%
857%
2.69%
2.26%
0.00%
0.00%
0.00%
0.00%

0.69%

Shown MW

1921

157

000

State-of-
Charge

4350%

g — Optimize Storage Profiles

Remaining
Hour  Required

Ending MW

NQC or VER Daily Maximum

Storage
Objective Under Confract  Cycle Physical  Storage Confinuous
h

Shown MW __ Function Opfimization Group ID  Combined IDs __ (MW) Capability Efficiency Energy (MWh)

4 Multi-Cydlestorage: 2.86 Cycles  ALAMIT_7_ES1
000 1 Multi-yclestorage: 2.73Cycles  CAM Storage 2MIRLOK 4000 27 87.00%
138 0 singleCydlestorsge JOANEC_2 STIBT3LNC EX) 10 80.00%
357 )

5.67 o
000 12
000 62
000

000 120
000 189
000 16
533 o

2688 o

B )

4702 o

sL24 )

4319 o

7.8 )

.24

1523 )

306 o
23 )
000 u
000 2

1. Refresh Tables updates the three query
tables with current data from LSE Showing
and Resource Custom Profiles worksheets

2. Reset Shown Hours sefs all values in Column G to zero, and
3. Optimize Shown Hours runs Solver to determine values to
minimize the objective function subject to constraints

160.00
581.00

v

Storage
Maximum Daily

MWh

1224.00
581,00

Difference Daily
MW

976,80
120196
45602
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Opfimization Group ID

Hour

Ending Show Hour

£ 10wn MW

State-of-
Charge

Remaining NQC or VER Daily Storage Storage
Hour  Required Objective Under Confract  Cycle Physical  Storage Confinuous Maximum Daily ~ Difference Daily
MWh

Ending MW

u v

Maximum

Shown MW __ Function Opfimization Group ID  Combined IDs __ (MW) Capability Efficiency Energy (MWh)  MWh

3| Multi-CycleStorage: 2.86 Cycles 1 Multi-Cycle Storage: 2.86 Cycles  ALAMIT_7_ES1 976.80
A koS e s tne | 2 oo - Mk eSiisge £ O Cim g SR a0c0 et w00 1200 proe
= Multi-CycleStorage: 2.86 Cycles 3 0.67% 0.67 A43.08% Single-CycleStorage JOANEC_2 ST3BT3,LNC 6.5 1.0 80.00% 581.00 581,00 456,02
6 |How to Opfimize Storage Resources: Multi-CycleStorage: 2.8 Cycles 4 173% 173 42.00%

1 ne or m tor Multi-CycleStorage: 2,86 Cycles 5 2.80% 280 40.5%
L Multi-Cycle Storage: 2.86 Cycles 6 0.00% 000 0%
Multi-Cycle Storage: 2.86 Cycles 7 0.00% 0.00 83.75%
Multi-Cycle Storage: 2.86 Cycles 8 0.00% 000 100.00%
Multi-Cycle Storage: 2.86 Cycles 9 0.00% 0.00 100.00%
Multi-CycleStorage: 2.86 Cycles 10 0.00% 000 100.00%
Multi-Cycle Storage: 2.86 Cycles 1 0.00% 000 100.00%
Multi-CycleStorage: 2.86 Cycles 12 4, 470 97.06%
Multi-CycleStorage: 2,86 Cycles 13 14.21% 14.21 83.18%
Multi-CycleStorage: 2.86 Cycles 14 18.26% 18.26 76.77%
Multi-Cycle Storage: 2.86 Cycles 15 23.%% 23% 61.80%
Multi-CycleStorage: 2.86 Cycles 16 25.99% 5.9 45.55%
Multi-Cycle Storage: 2.86 Cycles 17 25.00% .00 29.93%
Multi-CycleStorage: 2.86 Cycles 18 19.50% 1950 17.74%
Multi-Cycle Storage: 2.86 Cycles 19 14.87% 14.87 8.45%
Multi-CycleStorage: 2.86 Cycles 0 857% 857 3.09%
Multi-Cycle Storage: 2.86 Cycles 2 2.69% 269 1.41%
Multi-Cycle Storage: 2.86 Cycles 2 2.26% 226 0.00%
Multi-Cycle Storage: 2.86 Cycles P2 0.00% 000 21.75%
Multi-Cycle Storage: 2.86 Cycles 2 0.00% 000 4350%
Multi-CycleStorage: 2.79 Cycles 1 0.00% 000 2.75%
Multi-Cycle Storage: 2.79 Cycles 2 0.00% 000 4350%
Multi-CycleStorage: 2.79 Cycles 3 0.27% [ 43436
Multi-Cycle Storage: 2.79 Cycles 4 0.69% 028 43.26%
Multi-CycleStorage: 2.79 Cycles s 1.07% 043 P 99%
Multi-CycleStorage: 2.79 Cycles 6 0.00% 0.00 ONT4% . . . . . . .
Muki cydestorege: 275Cyles 7 ooo o o) Solver minimizes the objective function by setfing
Multi-Cycle Storage: 2.79 Cycles 8 0.00% 0.00 100.00% . . . .
V- Oydestorsge 27500k 9 ooox o 10000 values in the Show Hours column, indicating
Multi-Cycle Storage: 2.79 Cycles 10 0.00% 0.00 100.00% .
O e R o S ) fraction of NQC or VER to show each hour
Multi-CycleStorage: 2,75 Cycles 13- 0.23% 0.09 99,94%
Multi-CycleStorage: 2.79 Cycles 13 4.75% 19 98.75%
urn of th Multi-Cycle Storage: 2.79 Cycles 14 6.37% 255, 97.16%
n R R Multi-Cycle Storage: 2.79 Cycles 15 8.6% 346 5.00%
Multi-Cycle Storage: 2.79 Cycles 16 2.46% 379 92.64%
Multi-CycleStorage: 2.79 Cycles 17 9.07% 363 90.37%
Multi-Cycle Storage: 2.79 Cycles 18 6.86% 275 88.65%
it etiniilie Multi-CycleStorage: 2,79 Cycles 19 5.01% 201 87.40%
Multi-CycleStorage: 2.79 Cycles T 24%% 1.00 86.78%
Multi-Cycle Storage: 2.79 Cycles 2 0.14% 006 86.74%
Multi-CycleStorage: 2.79 Cycles 2 0.02% 001 86.74%
Multi-Cycle Storage: 2.79 Cycles 2 0.00% 000 100.00%
Multi-CycleStorage: 2.79 Cycles 2 0.00% 000 100.00%
1l Single-CycleStorage i 0.00% 0.00 1312%
th a falloff & single-Cycle Storage 2 0.00%. 0.00 26.23%
c city a single-Cyclestorage 3 0.63% 060 26.13%
single-Cylestorage 4 Lot 157 004
single-Cyclestorage s 256% 244 B.44%
single-Cyclestorage 6 0.00% 000 38.55%
.o
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Remaining NQC or VER Daily Sforage Maximum Storage
Hour State-of- Hour  Required Objective Under Contract ~ Cycle Physical  Storage Continuous Maximum Daily ~ Difference Daily
Opfimizafion Group ID__ Ending _Show Hour _ Shown MW _ Charge Ending MW Shown MW __ Function Optimization Group D Combined IDs__ (MW) Capability Efiiciency Energy (MWh)  MWh MWh
3 | Multi-Cycle Storage: 2,86 Cycles 1 0.00% 21.75% i -1.88 000 Multi-CycleStorage: 2,86 Cycles  ALAMIT_7_ES1 100.00 286 91.00% 400,00 1420 976.80
) Wi dese 230 2 oot o | 2 on o kst 2790des CAISE e ZARLCH oo 2 oo o000 1o
Mult-Cycle Storsge: 2.86 Cycles 3 0.67% 7 43086 3 136 138 Single-Cydlestorage JOANEC_2 STIBT3LNC 45602
How fo Opfimize Storage Resources: [JRINNERMERESamep e 4 1735 3 4200% 4 3s1 357
1 ne or m tor Multi-CycleStorage: 2,86 Cycles i 2.80% Bo 40.5% 5 551 5.67
L Multi-Cycle Storage: 2.86 Cycles 6 0.00% 0% 6 341 0.00
MulthCyclestorage: 2,86 Cycles 7 0.00% 8.75% 7 -7.86 000
Multi-Cyclestorage: 2,86 Cycles 5 0.00% 100.00% s 826 000
Multh-Cyclestorage: 2,86 Cycles s 0.00% 100.00% s 142 000
Multi Cyclestorage: 2860ycles 10 0.00% 100.00% 10 1376 000
MultiCyclestorage: 286Cycles 11 0.00% 100,00% 1 -4.06 000
Multi Cylestorage: 2860ycles 12 4 4 57.08% 12 5% 533 o
Multh Cyclestorage: 286Cycles 13 10.21% 14 83.18% 13 268 2688 o
Multi Cyclestorage: 285Cycles 14 18.26% 1506 7677% 1 506 B )
MultiCyclestorage: 286 Cycles 15 2% 235 6L80% 15 4666 4702 o
Multi Cyclestorage: 2860ycles 16 2.99% E 3 45.55% 16 s0.83 sL24 )
Multh Cyclestorage: 286 Cycles 17 5.00% = 29936 17 4883 4319 o i i - H
it e 26500 i3 ™ Sl ve  wa B Storage Maximum Daily MWh - Daily
Multi-CycleStorage: 2.86 Cycles 19 14.87% 1487 8.45% 19 22 85 ) MWh Shown constrained to less
Multi-Cyclestorage: 2860ycles 20 857% 7 309% B 15.41 1523 )
Multi-CycleStorage: 2.86 Cycles. 2 269% %) 1.41% 2 341 306 o gregfer than O for each [e[ge]¥]e}
MultiCyclestorage: 2860ycles 22 2.28% 5 000% 2 26 23 )
Multi Cyclestorage: 286 0ycles 23 000% 21.75% E EE3 000 u
Multi-Cyclestorage: 2.86Cycles 24 0.00% 4350% E 528 000 2
Multi Cyclestorage: 279 Cycles 1 000% 21.75% 522
Multh-Cyclestorage: 2,79 Cycles 2 0.00% 4350%
Multi Cyclestorage: 2,79 Cycles 3 0.2 1 43436
Multh-Cyclestorage: 2,79 Cycles 4 0.69% 3 43.20%
Multi Cyclestorage: 279 Cycles s 1075 3 4299
Multh-Cycletorage: 2,79 Cycles i 0.00% 64.74% i
e e e o State-of-Charge constrained to greater than
timizatlon # Multi-Cycle Storage: 2,79 Cycles 8 0.00% 100.00% Zero
h re: e Multi-CycleStorage: 2,73 Cycles s 0.00% 100.00%
2 Multi-Cyclestorage: 2.79 Cycles 10 0.00% 100.00%
Multi CyleStorage: 279Cycles 11 0.00% 100.00%
Multi-Cyclestorage: 2,79 Cycles 12 0,25 9 29.94%
Multi Cyclestorage: 279Cycles 13 4 3 58.75%
Multi-Cyclestorage: 279Cycles 14 6375 5 a716%
Multi Cyclestorage: 279Cycles 15 8.65% 6 %.00%
Multi Cyclestorage: 279Cydles 16 4% ] s260%
MulthCyclestorage: 279 Cycles 17 3075 3 0.37%
Multi Cylestorage: 279Cycles 18 6.58% s s5.65%
it etiniilie Multi-CycleStorage: 2,79 Cycles 19 5.01% L 87.40%
ng Multi-CycleStorage: 2,79 Cycles 20 249% 86.78%
MulthCyclestorage: 279Cycles 21 0.14% 6 86.74%
Multi Cyclestorage: 279Cycles 22 0.02% 1 86.74%
Multi Cyclestorage: 279Cycles 23 000% 100.00%
Multh-Cyclestorage: 2,79 Cycles x 0.00% 100,00%
ol Single-yclestorage 1 000% 1312%
th a falloff & single-Cycle Storage 2 0.00%. 26.23%
c city a single-Cyclestorage 3 0.63% 26.13%
single-cyclestorage 4 1.60% 7 B.86%
Single-Oydlestorage s 256% 4 B.49%
Single-Cyclestorage 6 0.00% 3355%
co e
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Test results and charts
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Built-In Validation Tests
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Built-In Validation Tests

« Multiple validation checks are
summarized on the Validation
Overview sheet

« No fests can fail for a valid
showing

» For test year, the Storage Excess
Capacity test may fail as long as
the MCC Bucket 4 test passes

 The overall test will indicate Falil

« The MCC Bucket 4 test will be
removed following the test year

California Public Utilities Commission

Result

Review

Refresh

Hourly System Cepacity

B Local Capacity

Flexible Capacity

Contract Date

Custom Profile

[ Shown Hours

Storage Excess Capacity

MCC Bucket 4 Storage Excess Capacity

storage Minimum State-of-Charge

storage Energy

Grouped Resource Inferconnection

Hyborid Delivercioity

Fail

Fail

Checks whether the fotal MWh shown
available across all 24 hours meet the
hourly requirements.

Checks whether shown local capacity
meetslocal requirements.

Checks whether shown local capacity
meets flex requirements.

Checks that each shown resource i
available for the curent showing month
according to the contract period.

Checks whether any custom resource
profiles exceed the current monthly NQC or
contracted NQC or VER

Passes I the shown hours of usage for each
resource are below the meximum alowed
in the resource databcse.

Checks that sufficlent excess capacity
cbove systern requirements across il hours
cre shown to supply the totai storage
charging needs, accounting for efficiency
losses.

Applies the Storage Excess Capacily test
only to Storage Resources indicated with
the MCC Bucket 4 flag

Checks the state-of-charge for each hour
fo ensure storage resources doesn't supply
unavaidble capacity.

Checks that storage resources donvt
exceed ther sted maximum energy
capaciies.

Cornperes groups of resources—either
hybrid peirs or colocated resources-and
checks that thelr combined effects do not
exceed interconnection limits.

Checks hybrid solar resources agairst their
poired storage according to their
delivercibilty statuses.

Check Capacity

Check Local

Check Flex

Check Contract Dates

Check Custom Profiles

Check Shown Hours

Check Storage Excess Capacity

Check MCC Bucket 4

Check Storage SOC|

Check Grouped Resources

Check Hybrid Deliverability

Go toSheet

Go toSheet

Go toSheet

Go toSheet

Go toSheet

Go toSheet

Go loSheel

Go toSheet

Go toSheet

Go toSheet

Go toSheet

R ORI EEERERR
R R R

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Overall

Fail

|A\I individual tests above must pass.

w
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Built-In Validation Tests

RA Capacity Showing Check — Compares overall system capacities of all
shown resources against LSE obligation

Confract Date Check — Compares each resource’s start and end dates
in the Resource Database against the current filing month

Custom Profile Check — Compares any custom capacity profiles against
resource limitations defined in the Resource Database

Hourly Capacity Check — Compares the number of hours each resource
is shown supplying capacity against the listed maximum daily run hours in
the Resource Database
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Built-In Validation Tests

Local Check — Compares shown capacities in each local area against
the LSE’'s local obligations

Flex Check — Compares shown capacities for each flexible category
against the LSE’s flex obligations

Storage State-of-Charge Check — Verifies that storage resource states of
charge do not fall below zero
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Built-In Validation Tests

Storage Capacity Exceedance Check — Verifies that overall shown
negative capacity does not exceed shown energy storage across all
resources

MCC Bucket 4 Storage Capacity Exceedance Check — Verifies that
overall shown negative capacity does not exceed shown energy storage
across MCC Bucket 4 resources

Storage Energy Check - Verifies that individual storage resource states of
charge do not exceed their energy storage capabilities

Storage Charge/Discharge Rate Check — Verifies that storage resource
states do not exceed their charge or discharge capacities
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Built-In Validation Tests

Grouped Resource Inferconnection — Verifies that collocated and hybrid
resources do not exceed their shared inferconnection limits

Hybrid Deliverability — Checks the deliverability status of hybrid solar
resources and verifies shown capacities do not exceed the applicable

deliverable limits.
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Built-In Validation Tests

» Click “Refresh” to update the
data for each test

 More detailed results can be
accessed by clicking “Go to
Sheet”

 Main calculations are accessible
from the Power Query Editor
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Result

Review

Refresh

Hourly System Cepacity

B Local Capacity

Flexible Capacity

Contract Date
Custom Profile

[ Shown Hours

Storage Excess Capacity

MCC Bucket 4 Storage Excess Capacity
storage Minimum State-of-Charge

storage Energy

Grouped Resource Inferconnection

Hyborid Delivercioity

Fail

Pass

Fail

Fail

Pass

Checks whether the fotal MWh shown
available across all 24 hours meet the
hourly requirements.

Checks whether shown local capacity
meetslocal requirements.

Checks whether shown local capacity
meets flex requirements.

Checks that each shown resource i
available for the curent showing month
according to the contract period.

Checks whether any custom resource
profiles exceed the current monthly NQC or
contracted NQC or VER.

Passes I the shown hours of usage for each
resource are below the meximum alowed
in the resource databcse.

Checks that sufficlent excess capacity
cbove systern requirements across il hours
cre shown to supply the totai storage
charging needs, accounting for efficiency
losses.

Applies the Storage Excess Capacily test
only to Storage Resources indicated with
the MCC Bucket 4 flag

Checks the state-of-charge for each hour
fo ensure storage resources doesn't supply
unavaildble capacity.

Checks that storage resources donvt
exceed ther sted maximum energy
capaciies.

Cormpares groups of resources-either
hybrid peirs or colocated resources-and
checks that thelr combined effects do not
exceed interconnection limits.

Checks hybrid solar resources agairst their
poired storage according to their
delivercibilty statuses.

Check Capacity

Check Local

Check Flex

Check Contract Dates

Check Custom Profiles

Check Shown Hours

Check Storage Excess Capacity

Check MCC Bucket 4

Check Storage SOC|

Check Grouped Resources

Check Hybrid Deliverability

Go toSheet

Go toSheet

Go toSheet

Go toSheet

Go toSheet

Go toSheet

Go loSheel

Go toSheet

Go toSheet

Go toSheet

Go toSheet

R ORI EEERERR
R R R

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Refresh

Overall

Fail

|A\I individual tests above must pass.

N
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Built-In Validation Tests — Reviewing Queries

« Open the Queries &

Connections Sidebar via
Ribbon Menu->Data->Queries & Connections

» Double-Click on any query

Creckopash| Gototnast]| | _watah |

I | e _ssten |
Fexbole Caoacity =3 o s, o CheckFlex  Go ol Refresh
Controct Dale fex o Creck Conlac: Dales Ge teshest Retresh
[Custon Profie. it > Check Custom Frodles  Ce fosnest Refresh

Srcun Fous , CheckSnownbour  Go losnest Rafesh
 sestenpaconamen
5 oncps oo Capac y 2 i e fot sor e ProassCapocly o tosnset zefsh
e storoge =t
CC 3usket 4 torage Bxcess Capacity o Check MCTBusker 4 G loSesl Refih

srcrcge tirirum Sre of Charge
CrockSeees$OC Gelosesl Refich

e —

Sroupd Reseurce [ olo comoction . Bles e Chock Grovped Rescuress GeloShoct Refiesh

| yooid Cotorctily S Check! ybiid Delverctily Go tosnest Reteih
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Built-In Validation Tests — Reviewing Queries

heckCustomProfiles - Power Query Editor - X
Fome | farsfom  ddiGolimn  ¥iew @
S | M sSek 4 7 o DauTpeTer [ Merse Queries - [ New Source -
=] Lo Hi = | =3 g s prsemowastieseirs + | O spperd Quariss > 2 | Rranesaes
Tosa’ Pt~ ORI cacR- Coumm = Rowe- Tovee | Coumne 3y baRephce Voes Dconbieies ol P Beneroan
Close quey T Tansom comie

Parameters Data Sources  New Query.

= Query Setting
BB Regions s
B 12 oetta mw HE

4 PROPERTIES
) AndAll 2 s s .
RequirementsAndAllocations Nam
quirementsAndAllocation: e E g

B3 SystemRequirements

_CheckCusmumﬁles
BB LocalRequirements

I Properti
BB FlexRequirements. K3 Advanced Editor

o B 12 octavwrer 12 oetomwiez (12 petavwies (12 oetamwres |12 vetamwies 12 o
« M Requirements and Allocatons 7]

4 APPLIED STEPS
ragel
B DRAllocations

Source 0}
B CheckCustomProfiles e

X Removed Other Columns o
4l Showing Information [3]
B Certifiation // Load subset of complete showing
Source = Table. SelectRous(
B r CustomProfil

B romeprimis R, Advanced Editor shows
e g code for all steps at once

e “Unspecified Inport”,
psForOptimization s i
Profile Source
R LSEShowingProfilesOptimized
9 P!

h
M 5o iceion s 2 s List.Transforn({1..24}, each "M HE " & Number.ToText(_))

)
cach [Profile Source:

)

// Calculate the difference between custom and default profile capacities
#"Added Multiple Columns” = List.Accumulate(

{1..20,

Source,

(state, current) => Table.AddColunn(

V' No syntax errors have been detected.
apacity
Cancel

BB CheckGroupedResources

kHybridDeliverability

MCCBucketdStoragebxc
ol Exports for Charts 3]
BB HourlyAvailability
BB LocalAvailability
BB FlexAvailability
ol Other Queries

26 COLUMNS. 2ROWS _ Column profiing based on top 1000 rows

PREVIEW DOWNLOADED AT 11:55 AM.
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Built-In Validation Tests — Reviewing Queries

| = | CheckCustomProfiles - Power Query Editor

il Home  Transform  Add Column

& D Bl Propertes E

[ Advanced Editor
Close & Refresh <
Laad! | Proviewsmi MT98

Close Query

PR Regions
4 @l Requirements and Allocations [7]
B RequirementsAndAll
B3 SystemRequireme
BB LocalRequirements
B FlexRequirements
BB storageAllocations
B DRAllocations
B Otherhllocatior
4@l showing Information [3]
F Certification
BB ResourceCustomProfiles
P LSEShowingProfilesUnoptimized
<l Exports for Optimization [5]
EB LSEShowingUnshownRequirement

FH Optimization

CustomProfiles

B CheckshownHours

oupedResour
BB CheckHybridDeliverability
3 CheckMCCBud

4l Exports for Charts [3
BB HourlyAvailability
BB LocalAvailability
BB FlexAvailability

M Other Queri
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Choose  Remov
Columns * Columns ~

Manage Columns

2 i

Split  Group 1
By

Column ™

M L2 MWHE20
o
o

fa] %

s Merge Queries - Ty Nesowce

. Append Queries ~ ral -]
Manage  Data source

Parameters = settings

Recent Sources.

[
1] Combine Files [ Enter Data

4 PROPERTIES
Name
i 3] s %) 4 APPLIED STEPS
Source
x A d Multiple Columns
Removed Other Columns

Code for selected Applied
Step appears in function bar

Click through Applied Steps
to see intermediate results

54 COLUMNS, 2 ROWS _ Column profiling based on top 1000 rows
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Charis

« Chart sheets use data loaded from Power Query to hidden sheets
« Data should automatically refresh when accessing a chart
« Use charts to visually assess compliance

» Resources are grouped together according to profile category for
readability
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Charis — Hourly Slice-of-Day Capacity Showings

« Required hourly capacities | I
include CAM DR Ond O_I_her . Hourly Slice-of-Day Capacity Showings against Requirements and CAM
CAM Allocations, and are
represented by the black line

« Shown capacities each hour are
represented by vertical bars

« Shown capacities above
requirements contribute toward

& 8 8
8 8 8

lourly Slice-of-Day Capacity Shown or Required (MW)
5
3

excess capacity for charging o
Storage
(STOrGge reSOU rces do nOT ConTri bUTe wm Bottery Storage e Other e Solar Fixed  wmmmm Solor Thermdl —So:r(::[::;dmi Unspecified Imporfs s Wi —t— i i

toward excess capacity in test)
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Charts - Local Area Capacity Showings

« Required local capacities for
each area are represented by
black diamonds

Local Capacity Showings against Requirements

- Shown local capacities
represented by vertical bars

» Local Capacity Areas are 6
assigned to each resource in the R
Resource Database

Capaci

M £ 0 * * * * * * * *
» Local capacities are specified
H - & s M e N
on the LSE Showing worksheet :
Local Capacity Area
msolar Thermal — mSolar Tracking mUnspecified Imports  mWind  » Local Requirement
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Charts - Flexible Capacity Showings

 Flexible Requirements for each
category are represented by
black diamonds

« Shown flexible capacities are
represented by vertical bars

* Flexible Categories are assigned
for each resource in the
Resource Database

* Flexible Capacities are specified .
on the LSE Showing worksheet

Flexible Capacity Showings against Requirements

or Required (MW)
~ IS N

y Shown
o
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Visual Basic Macros and Security

» The template uses macros written in Visual Basic for Applications (VBA) to help control
Power Query and Solver

* View the macro code through Excel’s VBA editor via [alt]+[F11] or
Ribbon Menu->Developer-> Visual Basic
» If macros are not permissible, the macro actions can be performed manually:
« Refresh queries manually

« Opening the Queries & Connections sidebar via
Ribbon Menu->Data->Queries & Connections

» Right-click on the required query
» Click Refresh
* Run Solver manually

« Make sure the Solver Add-In is active via
Ribbon Menu->File>Options>Add-ins>Manage: Excel Add-ins>Go...»>Solver Add-in

» Open the Solver dialog via Ribbon Menu->Data->Solver
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Navigate worksheet, specify resources, optimize storage
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Project Timeline

e Test Year
» Users are encouraged to provide feedback regarding the template
throughout the upcoming test year
» Expect periodic changes to the template design throughout the year along
with documentation

« A final template design, to be released in Summer 2024, will reflect new RA
rules, and incorporate feedback and improvements from the test year

 Post Test-Year

« CPUC will send LSEs fresh templates each month with current data for the
Resource Database, requirements, and allocations
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Tentative Office Hours

» Parties can submit qguestions and comments for Office Hours
beforehand

« Energy Division Staff will respond during Office Hours
« Dates are tentative and will be confirmed as the dates approach

» Please submit Office Hours questions with screenshots if possible to:
rafiing@cpuc.ca.gov

Office Hours (2-4 pm) Submit Questions By

September 21 September 18
October 19 October 16
November 16 November 13
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Questions?
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For more information:
robert.hansen@cpuc.ca.gov



